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BEA WebLogic Integration
Release Notes

BEA WebLogic Integration Release 2.1 Service Pack 1
Date: January 2002

Revised: March 8, 2002

Change History

The following table lists the changes included in BEA WebLogic Integration 2.1 since
the initial release.

Date Summary of Changes

March 8, 2002 � Added support for IBM AIX and Red Hat Linux. For details, see “Platform Support”
on page 5 and “Hardware and Software Requirements” on page 8.
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Release Note Topics

This document includes the following topics:

� About This Release of BEA WebLogic Integration

� What Is New and Improved in This Release

� Platform Support

� System Requirements

� Usage Notes

� Problems Fixed in This Release

� Known Limitations

� BEA Developer Center

� Contacting BEA Customer Support

For updated release note information, go to the BEA documentation Web site at the
following URL:

http://edocs.bea.com

About This Release of 
BEA WebLogic Integration

BEA WebLogic Integration 2.1 Service Pack 1 (SP1) is a single, unified platform that
provides the functionality needed to integrate business systems within an enterprise,
and to link those systems in a collaborative arrangement with an organization’s trading
partners.
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About This Release of BEA WebLogic Integration
Underlying this functionality is the industry-leading J2EE application server, BEA
WebLogic Server, which provides the critical infrastructure needed to develop
integrated solutions that support transaction management, security, fault tolerance,
persistence, and clustering.

WebLogic Integration 2.1 SP1 supports end-to-end business integration by providing
functionality in the following areas:

� Business process management makes possible the development of complex
e-business processes that integrate existing enterprise systems, cross-enterprise
applications, and human decision makers.

� Application integration makes it possible to integrate existing enterprise
applications with each other, and with new e-business applications.

� B2B integration makes possible the connection of trading partners over the
Internet, and the integration of EDI environments with WebLogic Integration.

� Data integration supports the seamless exchange of various data formats
between applications and between trading partners over the Internet.
BEA WebLogic Integration Release Notes 3



What Is New and Improved in This Release

BEA WebLogic Integration 2.1 Service Pack 1 (SP1) delivers the following new
functionality and enhancements:

� Support for AIX and Red Hat Linux platforms

WebLogic Integration 2.1 SP1 now supports IBM AIX 4.3.3, IBM AIX 5.1, and
Red Hat Linux 7.2. For details, see “Platform Support” on page 5 and
“Hardware and Software Requirements” on page 8.

� Support for BEA WebLogic Server 6.1 SP2

WebLogic Integration 2.1 SP1 now supports WebLogic Server 6.1 SP2;
however, only the new ebXML functionality requires using WebLogic Server 6.1
SP2. If you are not planning to use ebXML and you already have WebLogic
Server 6.1 SP1 installed, you are not required to upgrade to WebLogic Server
6.1 SP2.

� Support for the DB2 database

WebLogic Integration 2.1 SP1 supports the DB2 database on Solaris 7 and
Solaris 8 Sun platforms. If you plan to use a DB2 database, see “Prerequisites
for Using a DB2 Database.”

� Full SP1 installer and service pack upgrade installer

A full WebLogic Integration 2.1 SP1 installer is available. Use the full
installation if you have never installed WebLogic Integration or if you have
WebLogic Integration 2.0 or earlier installed.

If you already have WebLogic Integration 2.1 installed, and you have a BEA
WebSUPPORT account, you can use the service pack upgrade installer.
Information about downloading these installers is provided in Installing BEA
WebLogic Integration.

� WebLogic Integration - Business Connect

WebLogic Integration 2.1 SP1 introduces a new trading partner lightweight
client, called WebLogic Integration - Business Connect, for exchanging
messages with WebLogic Integration using the ebXML Message Service
business protocol. WebLogic Integration - Business Connect supports the
following features: ebXML, certificate authority integration, asynchronous
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Platform Support
processing, version 1.3.1 of the Java virtual machine, exporting of company
profiles and importing of backed-up profiles, communication outside a firewall
(when used with an external database), integration through file systems, FTP,
MQ Series, as well as enhanced JMS integration, and encryption of transport
server passwords in XML profiles exchanged with partners.

� Support for the ebXML Message Service Specification v1.0

This specification defines the message enveloping and header document schema
used to transfer ebXML messages with a communication protocol such as HTTP.
In addition, WebLogic Integration supports the creation and execution of
workflows that model ebXML business messages.

A sample application that demonstrates how two trading partners exchange
business messages using the ebXML protocol is provided in the
\samples\ebxml directory of your WebLogic Integration installation. For
details, see Running the B2B Integration Samples.

Platform Support

WebLogic Integration 2.1 Service Pack 1 is available on the following platforms.

Table 1. Platforms Supported on WebLogic Integration 2.1 SP1 See Note 1

Platform Version Database

Microsoft Windows NT 4.0 with Service Pack 6 or
later

Oracle 8.1.6
Oracle 8.1.7
Cloudscape 3.5.1
SQL Server 7 SP3
SQL Server 2000
Sybase System

11.9.2 See Note 2
BEA WebLogic Integration Release Notes 5



Note 1. Cloudscape is a pure-Java relational database management system that BEA
includes with WebLogic Server to allow you to run code samples. It is supported on
Windows platforms for development use only; it must not be used in a production
environment. Cloudscape is not supported on UNIX platforms.

For Microsoft SQL Server, Oracle, Sybase, or DB2, WebLogic Integration must have
network access to the database server. You must also have a database server account
with sufficient privileges to create a database with tables.

Note 2. The JDBC2 driver for Sybase is not bundled with WebLogic Server. You can
download it directly from the Sybase Web site. For download instructions, see the

Microsoft Windows 2000 � Professional with
Service Pack 2 or later

� Advanced Server

Oracle 8.1.6 (thin driver)
Oracle 8.1.7 (thin driver)
Cloudscape 3.5.1
SQL Server 7 SP3
SQL Server 2000
Sybase System

11.9.2See Note 2

Sun Solaris � 7 (formerly referred to
as 2.7)

� 8 - with system patches
recommended by Sun

Microsystems See Note 3

DB2 UDB V7.1
Oracle 8.1.6 (thin driver)
Oracle 8.1.7 (thin driver)
SQL Server 7 SP3
SQL Server 2000
Sybase System

11.9.2 See Note 2

Hewlett-Packard HP-UX 11.0 Oracle 8.1.6 (thin driver)
Oracle 8.1.7 (thin driver)
SQL Server 7 SP3
SQL Server 2000
Sybase System

11.9.2 See Note 2

IBM AIX � 4.3.3

� 5.1 with maintenance
level 1

Oracle 8.1.7 (thin driver)
DB2 7.2

Red Hat Linux 7.2 Oracle 8.1.7 (thin driver)

Table 1. Platforms Supported on WebLogic Integration 2.1 SP1 See Note 1

Platform Version Database
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Platform Support
BEA WebLogic Server 6.1 Installation Guide, available at the following URL:
http://edocs.bea.com

Note 3. The Solaris operating system patches for Java 2 JDK, including the Solaris
OpenWindows Motif patches, are required if you install the software using the GUI
installation procedure. The patches are available at the following URL:
http://java.sun.com/j2se/1.3/install-solaris-patches.html
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System Requirements

This section lists the hardware and software that must be installed to run WebLogic
Integration 2.1 Service Pack 1 (SP1), and it describes the databases that can be used
with this product.

Hardware and Software Requirements

This section lists the hardware and software requirements for installing and running
WebLogic Integration 2.1 SP1.

Table 2. Hardware and Software Requirements for WebLogic Integration 2.1 SP1

Microsoft Windows NT 4.0 with Service Pack 6 or later

Microsoft Windows 2000 Professional

Microsoft Windows 2000 Advanced

WebLogic
Server Platform

BEA WebLogic Server 6.1 with Service Pack 1 or higher

Note: If you plan to use ebXML functionality, which is available with WebLogic
Integration 2.1 SP1, then you must install WebLogic Server 6.1 SP2.

JDK JDK 1.3.1 is provided automatically with WebLogic Server; you do not need to install a Java
2 SDK separately.

Hardware and
Software
Requirements

� Intel Pentium II processor or later

� 400 MHz recommended

� 100 MB free disk space

� Network connection

� 256-MB RAM minimum (512 MB recommended)

Note: The 256-MB RAM recommendation is valid for one instance of WebLogic Server on
which WebLogic Integration 2.1 SP1 is running. You may need more memory if you
run two instances of WebLogic Server.

Databases One of the following: Cloudscape 3.5.1 (for development only), Oracle 8.1.6, Oracle 8.1.7,
Microsoft SQL Server 7.0 (Service Pack 3) or 2000, or Sybase System 11.9.2. (See “Database
Support” on page 12.)
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System Requirements
Sun Solaris 7 (formerly referred to as 2.7)
Sun Solaris 8 (formerly referred to as 2.8)

WebLogic
Server Platform

BEA WebLogic Server 6.1 with Service Pack 1 or higher

Note: If you plan to use ebXML functionality, which is available with WebLogic
Integration 2.1 SP1, then you must install WebLogic Server 6.1 SP2.

JDK JDK 1.3.1 is provided automatically with WebLogic Server; you do not need to install a Java
2 SDK separately.

The Solaris operating system patches for Java 2 JDK, including the Solaris OpenWindows
Motif patches, are required if you install the software using the GUI-based installation
procedure. The patches are available at the following URL:
http://java.sun.com/j2se/1.3/install-solaris-patches.html

Hardware and
Software
Requirements

� UltraSparc 5 or later

� Sparc 168 MHz or faster

� 100 MB free disk space

� Network connection

� 256-MB RAM minimum (512 MB recommended)

Note: The 256-MB RAM recommendation is valid for one instance of WebLogic Server on
which WebLogic Integration 2.1 SP1 is running. You may need more memory if you
run two instances of WebLogic Server.

Databases One of the following: Oracle 8.1.6, Oracle 8.1.7, Microsoft SQL Server 7.0 or 2000 using
jDriver, Sybase System 11.9.2, or DB2 UDB 7.2 (See “Database Support” on page 12.)

Table 2. Hardware and Software Requirements for WebLogic Integration 2.1 SP1 (Continued)
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Hewlett-Packard HP-UX 11.0

WebLogic
Server Platform

BEA WebLogic Server 6.1 with Service Pack 1 or higher

Note: If you plan to use ebXML functionality, which is available with WebLogic
Integration 2.1 SP1, then you must install WebLogic Server 6.1 SP2.

JDK JDK 1.3.1 is provided automatically with WebLogic Server; you do not need to install a Java
2 SDK separately.

Hardware and
Software
Requirements

� HP 9000 PA RISC

� 100 MHz or higher

� 100 MB free disk space

� Network connection

� 256-MB RAM minimum (512 MB recommended)

Note: The 256-MB RAM recommendation is valid for one instance of WebLogic Server on
which WebLogic Integration 2.1 SP1 is running. You may need more memory if you
run two instances of WebLogic Server.

For information about platform-specific configuration settings, see “Settings Required for
Running WebLogic Integration on HP-UX 11.0” on page 16.

Databases One of the following databases: Oracle 8.1.6, Oracle 8.1.7, Microsoft SQL Server 7.0,
Microsoft SQL Server 2000, or Sybase Server 11.9.2. (See “Database Support” on page 12.)

Table 2. Hardware and Software Requirements for WebLogic Integration 2.1 SP1 (Continued)
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System Requirements
IBM AIX 4.3.3
IBM AIX 5.1 with maintenance level 1

WebLogic
Server Platform

BEA WebLogic Server 6.1 with Service Pack 1 or higher

Note: If you plan to use ebXML functionality, which is available with WebLogic
Integration 2.1 SP1, then you must install WebLogic Server 6.1 SP2.

JDK JDK 1.3.1 is provided automatically with WebLogic Server; you do not need to install a Java
2 SDK separately.

Hardware and
Software
Requirements

� RS/6000 PowerPC-604 or higher

� 200 MHz or faster

� 280 MB free disk space

� 256-MB RAM minimum (512 MB recommended)

� Network connection

Databases One of the following databases: Oracle 8.1.7 or DB2 UDB 7.2 (See “Database Support” on
page 12.)

Red Hat Linux 7.2

WebLogic
Server Platform

BEA WebLogic Server 6.1 with Service Pack 1 or higher

Note: If you plan to use ebXML functionality, which is available with WebLogic
Integration 2.1 SP1, then you must install WebLogic Server 6.1 SP2.

JDK The JDK required for use with Red Hat Linux is not provided with WebLogic Server.
Download and install Sun Microsystems JDK 1.3.1_01 separately before installing WebLogic
Server. After installing the JDK, specify JAVA_HOME as described in “Specifying
JAVA_HOME for Red Hat Linux” on page 12.

Hardware and
Software
Requirements

� Intel Pentium II processor or higher

� 400 MHz or faster

� 100 MB free disk space

� 256-MB RAM minimum (512 MB recommended)

� Network connection

Databases Oracle 8.1.7 (See “Database Support” on page 12.)

Table 2. Hardware and Software Requirements for WebLogic Integration 2.1 SP1 (Continued)
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Specifying JAVA_HOME for Red Hat Linux

The JDK required for use with Red Hat Linux is not provided with WebLogic Server.
Download and install Sun JDK 1.3.1_01 separately before installing WebLogic
Server.

WebLogic Integration looks for the JDK in BEA_HOME. Because the JDK is installed
separately, choose one of the following methods to point to the correct JAVA_HOME. In
both methods, JAVA_HOME is the directory in which you installed JDK 1.3.1_01.

� Use the following commands to point to the proper JAVA_HOME before setting
your environment.

cd $BEA_HOME
ln -s $JAVA_HOME JAVA_HOME

� Use the following commands to change the definition of JAVA_HOME in
$WLI_HOME/setenv.sh to point to the directory in which you installed JDK
1.3.1_01.

cd $WLI_HOME
JAVA_HOME=JAVA_HOME

Database Support

WebLogic Integration 2.1 Service Pack 1 (SP1) requires the following
database-related resources:

� Access to a database server that is installed on the local network

� Database server account with privileges sufficient for creating a database with
tables

This section describes the databases supported for use with WebLogic Integration.

Cloudscape 3.5.1 (Windows Platforms Only)

BEA ships the Cloudscape software—a pure-Java relational database management
system (RDBMS)—with WebLogic Server. An evaluation copy of Cloudscape 3.5.1
(no expiration) is shipped with WebLogic Server 6.1.
12 BEA WebLogic Integration Release Notes



System Requirements
On Microsoft Windows platforms, Cloudscape is supported for development purposes
only. Cloudscape is not supported on Windows platforms for production
environments.

Cloudscape is no longer supported on UNIX platforms.

If you have an older version of Cloudscape, replace it with the 3.5.1 version packaged
with the latest WebLogic Server 6.1 distribution (full version; server with example).
You can download WebLogic Server 6.1 SP1 (or higher) from http://www.bea.com.

After you install WebLogic Server 6.1, the Cloudscape software is located in the
following directory on Windows systems:

%WL_HOME%\samples\eval\cloudscape

In the preceding pathname, WL_HOME represents the root directory of the WebLogic
Server installation. The Cloudscape driver consists of one file: cloudscape.jar.

Oracle 8.1.6

The Oracle 8.1.6 client libraries must be installed on a machine running WebLogic
Server 6.1. You must also have access to an Oracle 8.1.6 server. WebLogic Integration
uses the Oracle thin driver, which is delivered and installed with your WebLogic
Server distribution.

For more information about configuring the Oracle thin driver supplied with
WebLogic Server, see “Third-Party Drivers” at the following URL:

http://edocs.bea.com/wls/docs61/jdbc/thirdparty.html

Oracle 8.1.7

The Oracle 8.1.7 client libraries must be installed on a machine running WebLogic
Server 6.1. You must also have access to an Oracle 8.1.7 server. WebLogic Integration
uses the WebLogic jDriver for Oracle, which is provided with WebLogic Server 6.1.

For more information about configuring the WebLogic jDriver for Oracle with
WebLogic Server, see “Third-Party Drivers” at the following URL:

http://edocs.bea.com/wls/docs61/jdbc/thirdparty.html
BEA WebLogic Integration Release Notes 13



Microsoft SQL Server 7.0 or 2000

Before you can use Microsoft SQL Server, you must install the WebLogic jDriver for
Microsoft SQL Server JDBC driver (MSSQLServer4 Kit Version 7). This driver is a
pure Java Type-4 JDBC driver that provides connectivity to the Microsoft SQL Server.
You can download it from http://www.bea.com. Select the appropriate version of
the driver for SQL Server version 7.0 or 2000.

The WebLogic jDriver is bundled with WebLogic Server 6.1, and is installed on your
system when you install WebLogic Server 6.1.

A valid license entry for WebLogic jDriver for SQLServer 7.0 or 2000 is needed in
your WebLogic Server license file.

For details about using the JDBC specification for database access, see the following
URL:

http://edocs.bea.com/wls/docs61/jdbc/index.html

Sybase System 11.9.2

A Sybase jConnect driver is bundled with WebLogic Server. This driver is provided
for your use without charge. If you choose to use a later version, you must make the
appropriate changes to the config.xml file using the WebLogic Server
Administration Console for WebLogic Server 6.1.

DB2 V7.2

The DB2 V7.2 client libraries must be installed on a machine running WebLogic
Server 6.1 SP1 or higher.

Note: WebLogic Integration 2.1 SP1 now supports WebLogic Server 6.1 SP2;
however, only the new ebXML functionality requires using WebLogic Server
6.1 SP2. If you are not planning to use ebXML and you already have
WebLogic Server 6.1 SP1 installed, you are not required to upgrade to
WebLogic Server 6.1 SP2.

You must also have access to a DB2 V7.2 server. When you install the DB2 V7.2 client
on your machine, the JDBC 2.0 driver is also installed.

After installing WebLogic Integration 2.1 SP1, you must specify the DB2_HOME
environment variable in the setenv.sh file.
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Usage Notes
For more information about configuring the JDBC 2.0 driver with WebLogic Server,
see “Using Third-Party JDBC XA Drivers with WebLogic Server” at the following
URL:

http://edocs.bea.com/wls/docs61/jta/thirdpartytx.html

Usage Notes

This section contains the following usage information about WebLogic Integration
components and functions:

� Specifying the JDK for Red Hat Linux 7.2

�

� Settings Required for Running WebLogic Integration on HP-UX 11.0

� Support for Null Variables

� Design-Time Web Application JSP Delivery Change

� Sample Email Adapter Deprecated

� Address Messaging

� Nested Workflows

� Calling Programs Using SendXMLToClient

� BPM Plug-Ins in a UNIX Environment

� Using ebXML Message Services When Upgrading from
WebLogic Integration 2.1
BEA WebLogic Integration Release Notes 15



Settings Required for Running WebLogic Integration on 
HP-UX 11.0

Changes to default configuration settings and parameters are required to run
WebLogic Integration on an HP-UX 11.0 system.

In WLI_HOME/setenv.sh, locate the following lines:

HP-UX)
JAVA=$JAVA_BIN/java
JAVAC=$JAVA_BIN/javac
JAVA_OPTIONS="-Djava.compiler=NONE -Xms128m -Xmx512m"
export JAVA JAVA_OPTIONS JAVAC

Change:

JAVA_OPTIONS="-Djava.compiler=NONE -Xms128m -Xmx512m"

to:

JAVA_OPTIONS="-hotspot -Xms256m -Xmx256m"

Also, set the max_thread_proc to 512 and max_users to 128. You must have root
access to make this change.

Support for Null Variables

WebLogic Integration 2.1 SP1 supports null values in variables through the
wli.bpm.server.evaluator.supportsNull option in the startWebLogic script.

When this option is set to true, all variables are initialized to a null value. When this
option is set to false, all variables are initialized to their default values. The default
setting for this option is false.

For details about this option, see Starting, Stopping, and Customizing BEA WebLogic
Integration.
16 BEA WebLogic Integration Release Notes



Usage Notes
Design-Time Web Application JSP Delivery Change

The following information should be added to “Migrating Adapters to WebLogic
Integration 2.1” in Developing Adapters.

The WebLogic Integration 2.1 Service Pack 1 sample adapters (eMail, DBMS, and
sample) no longer distribute the JSP pages in a Web application archive (WAR).
Rather, the JSP pages are precompiled into Java Servlet classes. This approach
eliminates the need to precompile JSP pages when WebLogic Server starts. The Java
Servlet classes are delivered in the WEB-INF\classes\jsp_servlet directory in a
WAR file. Since the JSP pages are not bundled into the WAR file, the adapter
developer needs to establish the mapping between a URL pattern and a specific Java
Servlet class in the Web application descriptor WEB-INF/web.xml.

For each JSP page for your adapter, provide a Servlet declaration. For example,

<servlet>
<servlet-name>confconn</servlet-name>
<servlet-class>jsp_servlet.__confconn</servlet-class>

</servlet>

This declares a Servlet named confconn and associates it with a Java Servlet class
jsp_servlet.__confconn. The Web application container looks for this class in the
WEB-INF/classes directory in the WAR file. After declaring all Servlet classes,
associate each Servlet with a URL pattern via a servlet-mapping.

<servlet-mapping>
<servlet-name>confconn</servlet-name>
<url-pattern>confconn.jsp</url-pattern>

</servlet-mapping>

This servlet-mapping associates all HTTP requests for confconn.jsp to the
confconn Servlet in your Web application. The adapter developer must have a
servlet-mapping for all Servlets in the Web application. See the sample adapter’s
web.xml file for an example of all Servlet declarations and mappings needed for an
adapter.

Sample Email Adapter Deprecated

The sample Email adapter is deprecated in this release of WebLogic Integration. The
sample adapter will be removed from the product in a future release.
BEA WebLogic Integration Release Notes 17



Address Messaging

Use address messaging whenever you want guaranteed message delivery.

Nested Workflows 

Nested workflows must be analyzed for scalability because they can lead to transaction
timeouts. The parent of a transaction timeout envelops all children.

Calling Programs Using SendXMLToClient

Be careful about enabling access to a shell program, such as cmd.exe, because doing
so effectively defeats the SecurityManager, making it possible for a malicious
workflow to launch anything on the client computer. For better security, list only those
programs needed to execute the workflow.

WLPISec.properties contains a list (one item per line) of unqualified executable
files, such as the following:

� cmd.exe

� winword.exe

� mm.exe

BPM Plug-Ins in a UNIX Environment

The plug-in architecture uses the Image object from the AWT library. As a result, the
server needs to have the DISPLAY environment variable set in order to create this
object. The plug-in simply sends the image file across the wire and allows the client to
create the Image object.

When a UNIX system is used, an issue arises. Because the plug-ins make a connection
to the Xwindow server, logging off can bring WebLogic Server down, as well, even if
you start it with NOHUP and run it in background mode. For this reason plug-ins should
never instantiate any class that needs the Xwindow server.
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Problems Fixed in This Release
Using ebXML Message Services When Upgrading from 
WebLogic Integration 2.1

If you upgrade from WebLogic Integration 2.1 to WebLogic Integration 2.1 SP1, run
the following command to ensure that your ebXML data is loaded.

On Windows:

%WLI_HOME%\bin\bulkloader -load %WLI_HOME%\dbscripts\migrate\SystemRepData.xml

On UNIX:

$WLI_HOME/bin/bulkloader -load $WLI_HOME/dbscripts/migrate/SystemRepData.xml

Where WLI_HOME is the directory in which you installed WebLogic Integration.

Problems Fixed in This Release

The following table lists selected problems fixed in BEA WebLogic Integration 2.1
SP1, including a CR (Change Request) number for each problem. Most of these
problems were originally documented in the Release Notes for BEA WebLogic
Integration Release 2.1. For a complete list of problems fixed in BEA WebLogic
Integration 2.1 SP1, contact BEA Customer Support.

Table 3. Problems Fixed in BEA WebLogic Integration 2.1 SP1

Change Request
Number

Description

CR051037 The bulkloader command cannot be run with the initialize option.

CR051410 A deadlock situation can occur if insufficient connections are defined in the connection
pool.

CR052102 In certain configurations, loading the user interface for action plug-ins from within the
WebLogic Integration Studio sometimes fails due to different versions of
serialVersionUID of javax.swing.text.JTextComponent for JDK 1.3.0.
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CR055321 The zeroweight (formerly lightweight) client API throws a null pointer exception if
isExistMailbox() is not called. When a mailbox is created, if the
isExistMailbox() method is not called, any attempt to add a message throws a null
pointer exception.

CR055751 User notification should occur when the wlcsystem user is assigned different passwords
in the configuration file and the repository (such as the password and wlcsystem
passwords, respectively).

CR055780 The documentation needs to provide additional clarification about how to configure
WebLogic Integration for a clustered environment.

CR055832 The entry for com.bea.wlpi.admin.Admin.getTemplate() in Javadoc should be
updated to the method’s specified design.

CR056602 Format Tester’s translate functionality fails if an MFL document is created in Format
Builder with either an MFL or Field Codepage of Shift_JIS.

CR056858 Users who use Admin.getTasks() to produce a list of tasks often want to retrieve an
InstanceInfo associated with each task. A new getInstanceInfo method in the
Admin bean, available in Release 2.1 SP1, enables them to do so.

CR057621 An SQL exception may be thrown when data is being exported from the WebLogic
Integration B2B Console.

Resolution: In config.xml, the setting for JDBCConnectionPool should include a
MaxCapacity setting of 80 or greater to avoid this exception while a connection is being
established.

CR058834 A java.lang.NullPointerException exception can be thrown when the Test
hyperlink for a service on the application view summary page for application views with
Japanese names contains complex characters.

CR059193 A known issue with Microsoft SQL Server 7.0, where it loses the default value setting of
database columns while copying, can impact the WebLogic Integration server, which relies
on these default value settings, with an SQL exception being thrown.

Resolution: When you need to copy a Microsoft SQL Server 7.0 database, for instance,
when migrating a WebLogic Integration database, manually ensure that the default values
are identical with the original values.

Table 3. Problems Fixed in BEA WebLogic Integration 2.1 SP1 (Continued)

Change Request
Number

Description
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Problems Fixed in This Release
CR055321 The zeroweight (formerly lightweight) client API throws a null pointer exception if
isExistMailbox() is not called. When a mailbox is created, if the
isExistMailbox() method is not called, any attempt to add a message throws a null
pointer exception.

CR055751 User notification should occur when the wlcsystem user is assigned different passwords
in the configuration file and the repository (such as the password and wlcsystem
passwords, respectively).

CR055780 The documentation needs to provide additional clarification about how to configure
WebLogic Integration for a clustered environment.

CR055832 The entry for com.bea.wlpi.admin.Admin.getTemplate() in Javadoc should be
updated to the method’s specified design.

CR056602 Format Tester’s translate functionality fails if an MFL document is created in Format
Builder with either an MFL or Field Codepage of Shift_JIS.

CR056858 Users who use Admin.getTasks() to produce a list of tasks often want to retrieve an
InstanceInfo associated with each task. A new getInstanceInfo method in the
Admin bean, available in Release 2.1 SP1, enables them to do so.

CR057621 An SQL exception may be thrown when data is being exported from the WebLogic
Integration B2B Console.

Resolution: In config.xml, the setting for JDBCConnectionPool should include a
MaxCapacity setting of 80 or greater to avoid this exception while a connection is being
established.

CR058834 A java.lang.NullPointerException exception can be thrown when the Test
hyperlink for a service on the application view summary page for application views with
Japanese names contains complex characters.

CR059193 A known issue with Microsoft SQL Server 7.0, where it loses the default value setting of
database columns while copying, can impact the WebLogic Integration server, which relies
on these default value settings, with an SQL exception being thrown.

Resolution: When you need to copy a Microsoft SQL Server 7.0 database, for instance,
when migrating a WebLogic Integration database, manually ensure that the default values
are identical with the original values.

Table 3. Problems Fixed in BEA WebLogic Integration 2.1 SP1 (Continued)

Change Request
Number

Description
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CR055321 The zeroweight (formerly lightweight) client API throws a null pointer exception if
isExistMailbox() is not called. When a mailbox is created, if the
isExistMailbox() method is not called, any attempt to add a message throws a null
pointer exception.

CR055751 User notification should occur when the wlcsystem user is assigned different passwords
in the configuration file and the repository (such as the password and wlcsystem
passwords, respectively).

CR055780 The documentation needs to provide additional clarification about how to configure
WebLogic Integration for a clustered environment.

CR055832 The entry for com.bea.wlpi.admin.Admin.getTemplate() in Javadoc should be
updated to the method’s specified design.

CR056602 Format Tester’s translate functionality fails if an MFL document is created in Format
Builder with either an MFL or Field Codepage of Shift_JIS.

CR056858 Users who use Admin.getTasks() to produce a list of tasks often want to retrieve an
InstanceInfo associated with each task. A new getInstanceInfo method in the
Admin bean, available in Release 2.1 SP1, enables them to do so.

CR057621 An SQL exception may be thrown when data is being exported from the WebLogic
Integration B2B Console.

Resolution: In config.xml, the setting for JDBCConnectionPool should include a
MaxCapacity setting of 80 or greater to avoid this exception while a connection is being
established.

CR058834 A java.lang.NullPointerException exception can be thrown when the Test
hyperlink for a service on the application view summary page for application views with
Japanese names contains complex characters.

CR059193 A known issue with Microsoft SQL Server 7.0, where it loses the default value setting of
database columns while copying, can impact the WebLogic Integration server, which relies
on these default value settings, with an SQL exception being thrown.

Resolution: When you need to copy a Microsoft SQL Server 7.0 database, for instance,
when migrating a WebLogic Integration database, manually ensure that the default values
are identical with the original values.

Table 3. Problems Fixed in BEA WebLogic Integration 2.1 SP1 (Continued)

Change Request
Number

Description
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Problems Fixed in This Release
CR055321 The zeroweight (formerly lightweight) client API throws a null pointer exception if
isExistMailbox() is not called. When a mailbox is created, if the
isExistMailbox() method is not called, any attempt to add a message throws a null
pointer exception.

CR055751 User notification should occur when the wlcsystem user is assigned different passwords
in the configuration file and the repository (such as the password and wlcsystem
passwords, respectively).

CR055780 The documentation needs to provide additional clarification about how to configure
WebLogic Integration for a clustered environment.

CR055832 The entry for com.bea.wlpi.admin.Admin.getTemplate() in Javadoc should be
updated to the method’s specified design.

CR056602 Format Tester’s translate functionality fails if an MFL document is created in Format
Builder with either an MFL or Field Codepage of Shift_JIS.

CR056858 Users who use Admin.getTasks() to produce a list of tasks often want to retrieve an
InstanceInfo associated with each task. A new getInstanceInfo method in the
Admin bean, available in Release 2.1 SP1, enables them to do so.

CR057621 An SQL exception may be thrown when data is being exported from the WebLogic
Integration B2B Console.

Resolution: In config.xml, the setting for JDBCConnectionPool should include a
MaxCapacity setting of 80 or greater to avoid this exception while a connection is being
established.

CR058834 A java.lang.NullPointerException exception can be thrown when the Test
hyperlink for a service on the application view summary page for application views with
Japanese names contains complex characters.

CR059193 A known issue with Microsoft SQL Server 7.0, where it loses the default value setting of
database columns while copying, can impact the WebLogic Integration server, which relies
on these default value settings, with an SQL exception being thrown.

Resolution: When you need to copy a Microsoft SQL Server 7.0 database, for instance,
when migrating a WebLogic Integration database, manually ensure that the default values
are identical with the original values.

Table 3. Problems Fixed in BEA WebLogic Integration 2.1 SP1 (Continued)

Change Request
Number

Description
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CR055321 The zeroweight (formerly lightweight) client API throws a null pointer exception if
isExistMailbox() is not called. When a mailbox is created, if the
isExistMailbox() method is not called, any attempt to add a message throws a null
pointer exception.

CR055751 User notification should occur when the wlcsystem user is assigned different passwords
in the configuration file and the repository (such as the password and wlcsystem
passwords, respectively).

CR055780 The documentation needs to provide additional clarification about how to configure
WebLogic Integration for a clustered environment.

CR055832 The entry for com.bea.wlpi.admin.Admin.getTemplate() in Javadoc should be
updated to the method’s specified design.

CR056602 Format Tester’s translate functionality fails if an MFL document is created in Format
Builder with either an MFL or Field Codepage of Shift_JIS.

CR056858 Users who use Admin.getTasks() to produce a list of tasks often want to retrieve an
InstanceInfo associated with each task. A new getInstanceInfo method in the
Admin bean, available in Release 2.1 SP1, enables them to do so.

CR057621 An SQL exception may be thrown when data is being exported from the WebLogic
Integration B2B Console.

Resolution: In config.xml, the setting for JDBCConnectionPool should include a
MaxCapacity setting of 80 or greater to avoid this exception while a connection is being
established.

CR058834 A java.lang.NullPointerException exception can be thrown when the Test
hyperlink for a service on the application view summary page for application views with
Japanese names contains complex characters.

CR059193 A known issue with Microsoft SQL Server 7.0, where it loses the default value setting of
database columns while copying, can impact the WebLogic Integration server, which relies
on these default value settings, with an SQL exception being thrown.

Resolution: When you need to copy a Microsoft SQL Server 7.0 database, for instance,
when migrating a WebLogic Integration database, manually ensure that the default values
are identical with the original values.

Table 3. Problems Fixed in BEA WebLogic Integration 2.1 SP1 (Continued)

Change Request
Number

Description
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Problems Fixed in This Release
CR055321 The zeroweight (formerly lightweight) client API throws a null pointer exception if
isExistMailbox() is not called. When a mailbox is created, if the
isExistMailbox() method is not called, any attempt to add a message throws a null
pointer exception.

CR055751 User notification should occur when the wlcsystem user is assigned different passwords
in the configuration file and the repository (such as the password and wlcsystem
passwords, respectively).

CR055780 The documentation needs to provide additional clarification about how to configure
WebLogic Integration for a clustered environment.

CR055832 The entry for com.bea.wlpi.admin.Admin.getTemplate() in Javadoc should be
updated to the method’s specified design.

CR056602 Format Tester’s translate functionality fails if an MFL document is created in Format
Builder with either an MFL or Field Codepage of Shift_JIS.

CR056858 Users who use Admin.getTasks() to produce a list of tasks often want to retrieve an
InstanceInfo associated with each task. A new getInstanceInfo method in the
Admin bean, available in Release 2.1 SP1, enables them to do so.

CR057621 An SQL exception may be thrown when data is being exported from the WebLogic
Integration B2B Console.

Resolution: In config.xml, the setting for JDBCConnectionPool should include a
MaxCapacity setting of 80 or greater to avoid this exception while a connection is being
established.

CR058834 A java.lang.NullPointerException exception can be thrown when the Test
hyperlink for a service on the application view summary page for application views with
Japanese names contains complex characters.

CR059193 A known issue with Microsoft SQL Server 7.0, where it loses the default value setting of
database columns while copying, can impact the WebLogic Integration server, which relies
on these default value settings, with an SQL exception being thrown.

Resolution: When you need to copy a Microsoft SQL Server 7.0 database, for instance,
when migrating a WebLogic Integration database, manually ensure that the default values
are identical with the original values.

Table 3. Problems Fixed in BEA WebLogic Integration 2.1 SP1 (Continued)

Change Request
Number

Description
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CR059362 An incomplete import operation occurs during the import of a workflow that contains an
asynchronous application integration service call and an asynchronous response event to
capture the service response. Before the workflow is started, the service is removed from
the application view. When the workflow is executed, errors occur and a
NullPointerException is thrown.

CR059429 During the import of a template in which the value of the start organization is set to a
nonexistent organization, the first organization is selected.

CR059430 When a workflow is being imported, the Start Org (in the start node for a timed or
event-started workflow) may not exist.

CR059725 If multiple timed events are concurrently scheduled, the system will re-execute the original
timed event multiple times, because it is not being deleted from the database before the
system reschedules the next timed event.

CR059933 Pathnames used by the MDBGenerator are incorrect.

CR059972 The encoding Cp037 is no longer defined as a valid Codepage value in Format Builder. An
exception is thrown if you try to open an MFL document that contains a field with the
Cp037 encoding.

Resolution: Manually change the encoding to IBM037 in the field codepage specification,
as follows. Change:

<FieldFormat name=’delim1’ type=’String’ codepage=’Cp037’
length=’2’/>

to

<FieldFormat name=’delim1’ type=’String’ codepage=’IBM037’
length=’2’/>

CR060005 The WebLogic Integration B2B Console prevents updating a trading partner even when
that trading partner has been made inactive.

CR060143 Invoking an undeployed application view service using the application integration plug-in
puts the application view into an unstable state.

Resolution: To return your application view to a stable state, test the service from the
Application View Console or restart your WebLogic Server.

CR060156 The WebLogic Integration workflow instance ID is incorrectly persisted in certain
circumstances.

Table 3. Problems Fixed in BEA WebLogic Integration 2.1 SP1 (Continued)

Change Request
Number

Description
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Problems Fixed in This Release
CR060171 If you run a workflow developed with WebLogic Process Integrator 1.2 or 1.2.1 on a
WebLogic Integration 2.0 or 2.1 system, your workflow loses its ability to retain references
to stateless session beans.

CR060174 The MDBGenerator utility does not create deployment descriptors that correspond to
WebLogic Server 6.1 required descriptors.

CR060202 If you create an Invoke Error Handler action in a workflow without creating an XML
document (by leaving the editor blank), save the workflow, and then attempt to reopen it,
an error message is displayed.

CR060239 The XSL Transform action cannot successfully produce a nonXML result (such as HTML
output).

CR060412 Internationalization functions cannot use the XML editor to create XML messages or load
existing XML files in the WebLogic Integration Studio because the encoding of the
instance editor is hardcoded as UTF-8.

CR060421 After the server crashes, timed events and time-triggered start nodes that the user assumes
can be rescheduled cannot be recovered as expected.

Resolution: When you are defining a workflow template, you can indicate that you want a
timed workflow or event to be recoverable, by selecting a new Recoverable check box in
the Start Properties dialog box.

CR060600 The EDI adapter fails if WebLogic Integration is running on a DHCP machine and
Power.Server! is running on a different machine that is configured statically or
dynamically.

Resolution: Use either of the following approaches to correct this problem:

� Collocate both Power.Server! and WebLogic Integration on the same machine. This
machine can have either a static IP address or be DHCP.

� If Power.Server! and WebLogic Integration are running on separate machines, the
machine on which WebLogic Integration is running must have a static IP address.

CR060824 It is no longer possible to assign the value of an XML variable to a string variable, because
the XML variable value is now returned as a byte[] array, whereas the string variable
contains code to convert a DOM node to a string.

CR061557 UNIX platform-specific issues exist for the migration script for WebLogic Integration 2.1.

CR061777 The Studio does not recognize case-sensitive template definition names.

Table 3. Problems Fixed in BEA WebLogic Integration 2.1 SP1 (Continued)

Change Request
Number

Description
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CR062163 The document tree displayed in the XML Editor tree should be fully expandable when you
are working in read-only mode.

CR062263 If you want to dequeue messages transactionally, you must have one of the following
versions of WebLogic Server installed:

� WebLogic Server 6.1 SP1 + two rolling patches: CR057387_610sp1.jar and
CR061378_610sp1.jar

� WebLogic Server 6.1 SP2

If you are using WebLogic Server 6.1 SP2 as your platform, contact BEA Customer
Support for information about obtaining the latest patches.

Note: If your platform is either WebLogic Server 6.1 or WebLogic Server 6.1 with SP1,
and you try to remove a stateless session bean that is enlisted in a transaction that
has not yet been completed, your instance of WebLogic Server will throw
exceptions.

CR062265 Server crashes with complaint that PIPInput is null.

CR062268 Multiple threads execute a single workflow instance simultaneously.

CR062283 The error recovery message store is not being restored properly.

CR062301 Problems occurred with numeric parsing in different locales.

CR062303 Unexpected behavior occurs after a Workflow Changed dialog box is canceled.

CR062344 The ~config/bpmdomain/startWeblogic script is not working as expected on
UNIX platforms.

CR062346,
CR062347

Messages addressed to a nonexistent template instance should be deleted.

CR062406 Variable renaming was not working as expected during operations involving “null.”

CR062472 EventAttribute produces inconsistent behavior when used on a missing JMS Property.

CR062633 Although it behaves as documented, the fact that ToInteger returns 0 for floating point
arguments is unsatisfactory. In this release, ToInteger has been modified so that it never
returns 0. If invalid data is passed to it, it throws an exception.

Table 3. Problems Fixed in BEA WebLogic Integration 2.1 SP1 (Continued)

Change Request
Number

Description
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Problems Fixed in This Release
CR062903 The Admin.checkForTemplateInstances() method returns true if there are
instances that have not completed yet. Request for clarification in documentation about the
fact that this description refers to running instances.

CR062998,
CR066034

Addressed messages sent to the same event node can fire multiple times.

CR063011 The problem that was caused by making multiple calls to the WebLogic Integration API
from within a session bean has been fixed.

CR063066 An unexpected namespace error occurs during schema validation in a RosettaNet 2.0
conversation when a namespace is defined as an attribute of the root node of an XML
document.

CR063124 Format Builder incorrectly processes large binary files.

CR063135 An exception is generated if you use the WebLogic Integration Studio after adding a new
folder to the WLAI.Namespace.Root folder in the XML repository.

Resolution: Do not add any custom folders to the WLAI.Namespace.Root folder in the
XML repository.

CR063189 The Format Builder popup context menus are not accessible when the navigation tree is in
certain states.

CR063403 In the Start workflow dialog box the same workflow is listed repeatedly for different
effective dates, and it is impossible to differentiate between listings.

CR063458,
CR063609

For RosettaNet RNIF 1.1 and RNIF 2.0, an exception was logged if you set the template
variable retryCount to a value of 0.

CR063595 The ADK did not provide adequate support for radio buttons in Release 2.1.

CR063885 WebLogic Integration provides application integration functionality that allows you to
create an application view with invalid characters.

Table 3. Problems Fixed in BEA WebLogic Integration 2.1 SP1 (Continued)

Change Request
Number

Description
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Known Limitations

This section describes known limitations in the BEA WebLogic Integration software.

Change Requests

The following table describes limitations that are documented in formal change
requests (CRs). Whenever available, a recommended workaround is provided.

1 CR036730

Problem In the WebLogic Integration Studio, OR joins can be triggered only once, and they
cannot be inserted in loops.

Platforms All

Workaround None

2 CR037903

Problem When updating a user’s properties in the WebLogic Integration Studio, you cannot
modify the user’s password.

Platforms All

Workaround Use the WebLogic Server Administration Console to update the user’s password. See
Starting, Stopping, and Customizing BEA WebLogic Integration for more information.

3 CR045158

Problem WebLogic Integration user and password information is exposed in the
wlai.properties file. The user name and password associated with the host address
are used by the event router to authenticate itself when posting events. This information
is not available to the ApplicationViewDeployer when the Application View is
deployed. The extra information is available in wlai.properties.

Platforms All

Workaround None, however we recommend selecting a user name other than system.
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Known Limitations
4 CR047229

Problem The user cannot scroll through text that is longer than the length of the text field in
application integration plug-in event and start conditions.

Platforms All

Workaround Open the expression builder to build or view a condition for which the text is longer than
the length of the condition text field.

5 CR048110

Problem When a data integration user tries to enter values on a tab in a binary window, the text
being typed is not inserted at the location indicated by the cursor.

Platforms Windows NT and 2000

Workaround Enter your text changes in the text portion of the hex tab of Format Tester.

6 CR048606

Problem When the WebLogic Integration Studio is used on a UNIX system, spaces are displayed
as special characters in application integration Plug-In View Definition dialog boxes for
viewing schema definitions of event documents and service requests and responses.

Platforms UNIX platforms (Solaris and HP)

Workaround None

7 CR048918

Problem Login user names for the Worklist client are case-sensitive. Tasks assigned to a user may
not be listed in a Worklist application if the user logs in to the application with a name
spelled in a different case.

Platforms All

Workaround In the Worklist application, choose View→Refresh.
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8 CR049068

Problem If you shut down the B2B engine abnormally and subsequently try to use the Bulk
Loader utility, you get an error message, indicating that the B2B engine is still running
or was shut down abnormally.

Platforms All

Workaround Shut down the B2B engine from the WebLogic Integration B2B Console. Do not use
Ctrl-C to shut down the B2B engine. For recommended ways to shut down the B2B
engine, see “Monitoring B2B Integration” in Administering B2B Integration.

9 CR050074

Problem If your application startup class is called before the B2B engine startup, the application
startup tries to access a noninitialized instance of the B2B engine, causing an error such
as the following:

ERROR: Collaboration Agreement
CXMLsupplierConversation|1.1|cxml|ACSNHub|AN01000033621-T
is not yet registered in runtime. This error occurs if the
Server is not initialized properly or the
Collaboration Agreement is not registered in runtime by the
WebLogic Integration B2B Console.

Platforms All

Workaround If your application uses a startup class, you must deploy that class before deploying the
B2B integration startup class.
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Known Limitations
10 CR050226

Problem Under the following conditions, WebLogic Integration can start the wrong workflow on
receipt of a business message:

� The same endpoint URI is assigned for different business protocols or different
versions of the same business protocol.

� The repository contains two collaboration agreements between the same trading
partners.

� Those collaboration agreements define the same roles and parties, but are associated
with different business protocols (or different versions of the same business
protocol).

Platforms All

Workaround Assign different endpoint URIs for each business protocol (or for each version of a
business protocol).

For example, if one collaboration agreement references RosettaNet 1.1 and the other
references RosettaNet 2.0 (through the trading partner delivery channels), you must
assign one endpoint URI for RosettaNet 1.1 and another for RosettaNet 2.0.

11 CR050432

Problem In the Studio, run-time exceptions occur when variable names begin with numeric
characters.

Platforms All

Workaround Begin variable names with alphabetic characters.

12 CR051059

Problem You cannot update the data for parties in a collaboration agreement in the WebLogic
Integration B2B Console.

Platforms All

Workaround If you create a party for a collaboration agreement, and subsequently want to modify any
of the attributes associated with it (such as trading partner name, party identifier, role
name, or delivery channel), you must delete the party, and then create a new one with the
desired attributes.
BEA WebLogic Integration Release Notes 33



13 CR051469

Problem When you use a proxy server and do not set your system to bypass local addresses, you
get the following error when running the Hello Partner sample:

ERROR> The requested URL could not be retrieved

Platforms All

Workaround To bypass local addresses, change your Web browser configurations as follows:

� Internet Explorer:

Choose Tools→Internet Options →Connections →LAN Settings→ Bypass proxy
server for local addresses.

� Netscape:

Choose Edit→Preferences→Advanced→Proxies→View.

Add your localhost to Exceptions.

14 CR052680

Problem Apache’s ant command is not internationalized. The ant command is used to build
application integration adapters. When an error occurs during the build process, the error
text may not be displayed properly in Windows environments in which the natural
language used in not English. For example, in a Japanese Windows environment you
might see the following:

[java] ...\jsp_servlet\_addevent.java:20: ’class’ ??????
’interface’ ?????????????B

Platforms All

Workaround None

15 CR052994

Problem The WebLogic Integration software does not currently provide methods or properties for
specifying use of the Japanese character set for sending messages and for the
contentType of the mail header (for example, Content-Type: text/plain;
charset="ISO-2022-JP").

Platforms All

Workaround Email adapter code is provided with WebLogic Integration. Japanese users are free to
alter this code to allow for the specification of character sets. Keep in mind, however,
that the sample email adapter does not support multibyte characters.
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Known Limitations
16 CR053242

Problem The WebLogic Integration Studio does not handle time zones correctly. For example, the
client may send a local date/time string to the server, which then parses the string in its
own time zone. This procedure creates ambiguities when the server and client are in
different time zones.

The following areas are affected:

� Any entity associated with a date value expressed as a string in which the time zone
is implicit (for example, workload and statistics queries, and the effective and
expiration dates for a template definition).

� Any date/time value that the client rounds up or down (for example, task reroutes and
the effective and expiration dates for a template definition).

Platforms All

Workaround Use GMT for all time values when clients and server span multiple time zones.

17 CR055188

Problem Once an Oracle database account is used and a createDB operation is performed, if you
invoke createDB again, you must drop the current username and password (using an
Oracle script or Enterprise Manager) and then recreate the account. Otherwise, when
attempting to bulk load data, the database returns an invalid operation error or an error
similar to the following:

<Aug 20, 2001 11:06:59 AM PDT> <Error> <WLC> <<BulkLoader>
ERROR: WLC is still running or was shut down abnormally.>
ERROR: WLC is still running or was shut down abnormally.
<Aug 20, 2001 11:07:01 AM PDT> <Error> <WLC> <<BulkLoader>
ERROR: WLC is still running or was shut down abnormally.>

This problem most often occurs when you install a new version of WebLogic Integration
but continue to use an existing Oracle database account. This error message is also
displayed when you invoke createDB once but repeatedly bulk load data.

Platforms All

Workaround Ensure that the server is stopped. Use the Bulk Loader -force option.

Caution: The Bulk Loader force option should not be used if the server is running.
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18 CR055652

Problem The Application View connection values for initial and maximum cannot be the same
number due to a limitation in WebLogic JCA.

Platforms All

Workaround None

19 CR055967

Problem If you log off from one server and log on to another, the following JMSException is
thrown. The topic session for the notifier is not released during logoff.

The server was unable to complete your request.
JMSException: Connection not found
Start server side stack trace:
weblogic.jms.common.JMSException: Connection not found

Platforms All

Workaround None

20 CR057163

Problem Attempt to connect fails because of a license-related exception resulting from the
absence, from the classpath, of the license.bea file. The pathname may be too long
for the system to read it. (It is possible that after repeated executions of the setenv
program, BEA_HOME (D:\bea\), the directory in which the license.bea file
resides, is no longer included in the classpath.)

Platforms Windows (on Intel)

Workaround Open a new DOS prompt window and try again.

21 CR057562

Problem The names of the roles used in the PIP3A2 template have been changed from Buyer and
Seller to Customer and Product Supplier.

Platforms All

Workaround If you have private workflows that call the 3A2 private workflows (in a pre-SP1 release
of WebLogic Integration), you must update the roles in your private workflows.
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Known Limitations
22 CR057771

Problem The documentation that explains how to define workflow templates in the Studio does
not warn you that unless you state that a variable is of type input, that variable is not
assigned when you instantiate a workflow from the API.

Platforms All

Workaround None.

23 CR058127,
CR058732

Problem When the RosettaNet 2.0 protocol is used, the name of a trading partner may not include
Chinese or Japanese characters. A trading partner with such a name cannot exchange
business messages.

Platforms All.

Workaround None.

24 CR058307

Problem The shutdown of a spoke which might have initiated conversations blocks if WebLogic
Server is shutting down at the same time.

Platforms All

Workaround Always explicitly shut down the B2B engine independently of WebLogic Server using
the WebLogic Integration B2B Console. If business process management functions are
running, shut down the process engine first using WebLogic Integration Studio. Next
shut down the B2B engine, using the WebLogic Integration B2B Console. If shutdown
of the B2B engine is invoked with the TERMINATE mode, an underlying WebLogic
Server, listening for incoming requests, is required.

25 CR058949

Problem The Format Builder is unable to open palettes other than the default palette.mfl file.

Platforms All

Workaround Close the Format Builder and rename the file required to be displayed in the palette to
palette.mfl, then restart the Format Builder.
BEA WebLogic Integration Release Notes 37



26 CR059332
CR058852

Problem Problems have occurred when running WebLogic Integration samples on Windows 2000
Advanced Server systems over an MSSQL 2000 database.

Platforms Windows 2000 Advanced Server / MSSQL 2000

Workaround The row-locking mechanism has changed between the Microsoft SQL 7.0 and 2000
databases. A solution is in progress and will be available in a future release.

27 CR059475

Problem Application integration plug-ins do not detect the status of a wlai-ejb-server when
the server is down at design time. A message similar to the following is displayed:

The server was unable to complete your request. Unknown error:
NameNotFoundException:
Unable to resolve com.bea.wlpi.Admin.
Resolved: 'com.bea.wlpi' Unresolved:'Admin'

Platforms All

Workaround None

28 CR059746,
CR062984

Problem The introduction of milliseconds as a unit of time broke backward compatibility for
timed-triggered workflows and for TimedEvent Actions.

Platforms All

Workaround If you have created workflows with an earlier release of WebLogic Integration (or any
release of BEA WebLogic Process Integrator), then you must manually reset the correct
time units in the Start nodes (for timed-triggered workflows) and in all TimedEvent
Actions.
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29 CR060313

Problem You cannot uninstall Power.Enterprise! Server or Client software if you try to do so from
the Windows NT (or Windows 2000) Add/Remove Programs dialog box. The uninstall
program looks for the jre in the directory from which the Power.Enterprise! software
was initially installed.

Platforms Windows

Workaround Select the Uninstall item from the PowerIt program group on the Start menu. At the end
of the uninstall procedure, you may need to remove the installation directory manually.

30 CR060335

Problem WebLogic Integration fails to create an extended property for a trading partner on UNIX
systems. An exception similar to the following is displayed:

<Oct 16, 2001 7:11:50 PM GMT-08:00> <Error> <B2B>
<<Repository> ERROR: In SQLExecutor.doUpdate,
a SQL Exception was caught while executing a SQL
Statement: java.sql.SQLException: ORA-01400:
cannot insert NULL into ("BOB"."XML_NODE"."NAME")

Platforms UNIX

Workaround Manually edit the exported XML file to add the extended property. For example, to add
an extended property for the trading partner named TPSpoke:

1. From the WebLogic Integration B2B Console, choose B2B→Config→Export.

2. Select trading partner TPSpoke for export without exporting all referenced entities.

3. Edit the exported XML file to add the extended property.

4. Shut down the B2B engine from the WebLogic Integration B2B Console.

5. Import the modified XML file.

6. Restart the B2B engine.
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31 CR060401

Problem Creating a B2B entity using the WebLogic Integration B2B Console sometimes takes
several minutes and results in an exception similar to the following:

<Oct 17, 2001 10:58:08 AM PDT> <Error> <B2B> <<Repository>
ERROR: Error getting a Connection from the DataSource
"WLCHub.DS" in Repository Session - SQLException: WLCHub.DS>

Platforms All.

Workaround Edit config.xml to increase the default MaxCapacity setting for the
JDBCConnectionPool from 36 to 80.

32 CR062137

Problem Task and workflow comments are being truncated.

Note: Workflow and task comments are limited to a maximum of 254 characters.
Comments exceeding this limit are truncated and no exception is thrown.

Platforms All

Workaround Do not include more than 254 characters in your task and workflow comments.

33 CR062442

Problem When the fromDUNS is set to a value in the customer’s private workflow, and that value
is not declared as a business ID of the party identifier in the repository, the customer’s
public workflow throws a null pointer exception.

Platforms All

Workaround None

34 CR062634

Problem The SendXMLToClient dialog box returns text that does not match the text you
selected in that box. For example, if you select OK, the word yes is displayed in the XML
reply (instead of OK).

Platforms All

Workaround None
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35 CR062846

Problem While trying to start WebLogic Server, the RunSamples script (in
$BEA_HOME/wlintegration2.1/samples/bin) gives a syntax error about an
unexpected elif. This problem is caused by a script called usejdbc2written in Korn
shell syntax.

Platform Solaris with DB2

Workaround Replace the Korn shell syntax in the usejdbc2 script (in $DB2_HOME/java12) with
Bourne shell syntax:

1. Replace if [[ ... ]]then
with
if [ ... ]; then.

2. Replace elif [[ ... ]] then
with
elif [ ... ]; then.

3. Run setenv.sh.

4. Run the RunSamples script again.

36 CR062855

Problem An event that follows a Start node immediately is not activated unless the flow enters a
quiescent state before reaching that event.

Platforms All

Workaround Place a timed event before the Event node.
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37 CR063114,
CR066059

Problem Format Builder stops responding after saving an MFL document.

Format Builder uses an XSL style sheet to create DTD and XML Schema from the MFL
documents after it is saved. Certain field combinations within an MFL document cause
the Xalan to hang when a DTD or XML Schema document is being created.When this
problem occurs you must terminate the Format Builder process. Do not hesitate to do so;
you will not lose your MFL document. A DTD and or Schema will not be created,
however. The default output setting of Format Builder automatically creates a DTD on
save.

Platforms All

Workaround To turn off automatic DTD and XML Schema creation, make sure the check boxes in the
Tools / Options . . . dialog box are not selected.

38 CR063709

Problem The RosettaNet Security Sample throws an exception when a single database is used for
two peers and the database tables for peer1 are overwritten by peer2. (When peer1 is
booted, it cannot add the certificate and key for the appropriate users. Because the
database tables have been overwritten, the system boot cannot even pick the correct
certificate names for which to search in the startup script.)

Platforms All

Workaround If possible, use different databases for different peers. For example, have peer1 use
MSSQL and peer2, Oracle. If you must run two peers on one machine and both peers use
the same database server, make sure that:

� With MSSQL—A different database name is used for each peer, such as WLIDB for
peer1 and WLIDB2 for peer2.

� With Oracle—A different Oracle user account is used for each peer, such as
kevin/kevin for peer1 and nina/nina for peer2.

Specify every database you use for this sample on the RunRN2Security command
line, as follows:

RunRN2Security database_for_peer1 database_for_peer2

setDBVars and setDBVarsExt for the two peers are set appropriately for two
databases and users, as follows:

� /bea/wlintegration2.1/config/samples/RN2Security/config/
peer1/dbInfo/database

� /bea/wlintegration2.1/config/samples/RN2Security/config/
peer2/dbInfo/database
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39 CR064277

Problem Exporting a workflow that contains a task that uses the invoke workflow exception
handler action will cause a SAX parser error and may cause the workflow to become
corrupted, losing variables, nodes, and exception handlers defined.

Platforms All

Workaround Avoid using the invoke exception handler case.

40 CR064443

Problem The first window displayed by both the full uninstaller and the service pack upgrade
uninstaller contains the following message:

“This will completely remove all components installed by InstallAnywhere. It will not
remove files and folders created after the installation.”

Platforms All

Workaround This message is imprecise. It should say, instead, that the uninstall process will remove
the upgrade and return the software to its pre-upgrade state.

41 CR064564

Problem The organization view in the WebLogic Integration Worklist is not updated when you
add a new organization through the following procedure:

1. Log in to the Studio and the Worklist with the same user account (such as joe).

2. In the Studio, add an organization.

3. Select the new organization from the Organization drop-down list.

4. Add yourself (joe) as a user to the new organization.

5. In the Worklist, look for the new organization in the drop-down list.

The problem is that the new organization is not listed. Even if you refresh the Worklist
(by choosing View→Refresh), the organization is still not listed.

Platforms All

Workaround Log off from the Worklist and then log on again.
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42 CR064686

Problem The calendar feature is broken.

Platforms All

Workaround The timezone of the calendar must match the timezone of the machine on which the
server is running. Make sure you use the correct timezone.

43 CR064716

Problem The WebLogic Integration source code checks the PRODUCTNAME column of the
master.dbo.spt_mda table, and it relies on finding the following string: Sybase SQL
Server. If, instead of this string, the source code finds a variable, @@version, which is
set to Adaptive Server Enterprise, then users get the following
com.sybase.jdbc.SybSQLException:

SET CHAINED command not allowed within multi-statement
transaction.

Platforms Sybase 11.9.2

Workaround jConnect implements the JDBC method getDatabaseProductName by calling the
sp_mda stored procedure that is set up by the installjconnect script. This script
populates the master..spt_mda table with information to be returned by metadata
access methods.

If the PRODUCTNAME column of the master.dbo.spt_mda table contains the
@@version variable, then you must change the variable to Sybase SQL Server by
running the following SQL statements:

� update master.dbo.spt_mda set query = 'Sybase SQL Server’
where mdinfo = ‘PRODUCTNAME’ querytype = 6

� update master.dbo.spt_mad set query = 'select ''Sybase SQL
Server''' where mdinfo = ‘PRODUCTNAME’ querytype = 2

44 CR065136

Problem The upgrade installer does not provide an option migrating the Cloudscape database.

Platforms All

Workaround None required. Cloudscape is not supported for production environments.
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45 CR065220

Problem When you use two XSLTs in two different tasks in a workflow, the XML event starts the
workflow. The XML file that starts the workflow is the input XML for the first
XSLTransform in Task1. The output of the first XSLT is input for the second
XSLTransform in another Task2.

The user tried sending the XML files to the BPM process to start the workflow.

Only one particular XML file is causing the problem.

Platforms All.

Workaround Install the following patch file for WebLogic Server 6.1 SP1:
CR065345_610sp2.jar. To obtain this patch, contact BEA Customer Support.

46 CR065392

Problem An exception is thrown when a large (over 20 MB) binary file is received from
WebLogic Integration - Business Connect.

Platforms All

Workaround Use the following tuning parameters:

� StartWebLogic: Increase the heap size to 512MB.

� Database: Make the database large (up to 300MB).

� Increase the Transaction Log space (or rollback segment) to 100MB.

� Turn off the database shrinking.

� WebLogic Integration [formerly WLPI] EJBs: Edit the deployment descriptors of
wlpi-ejb.jar and wlpi-ejb-mdb.jar. Edit ejb-jar.xml from
wlpi-ejb-mdb.jar.

� Look for all 90-second transaction timeouts and raise each one to 1090.

� Edit weblogic-ejb-jar.xml from the wlpi-ejb.jar file and raise all
90-second timeouts to 1090.
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47 CR065397

Problem When I go to the party tab for a particular collaboration agreement and select Enable and
Register this Collaboration Agreement, the b2b.log file seems to indicate that the
enable-and-register operation is successful, but the B2B Console continues to wait for
the operation to finish.

Platforms Windows (Intel)

Workaround Execute the same operation (that is, enable and register the specified collaboration
agreement) from the monitoring tab, instead.

48 CR065456

Problem There is no ebXML plug-in online help from the Studio help menu.

Platforms All

Workaround None

49 CR065631 On a WinNT or Win2000 machine, the installation fails at the Choose Install Set window
if you are using a version of the JDK that is earlier than 1.3.x.

Note: The JDK 1.3.1 is shipped with WebLogic Server 6.1, so you should have it
installed on your system.

Problem If the user has not installed the JDK on a new Windows NT or Windows 2000 system,
then the installer fails when the Choose Install Set window is displayed, instead of
proceeding to give the user the option of selecting or creating a directory to serve as
BEA_HOME.

Platforms Windows 2000 and Windows NT

Workaround Install the JDK 1.3.1 on the target machine and start the installation again.

50 CR065852

Problem If you run RunSamples.cmd more than once, an exception may be generated and
captured in the config\samples\logs\samples.log file. (The problem does not
occur the first time you run RunSamples.cmd.)

Platforms

Workaround This exception is benign; you can ignore it.
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Sample Test Exception Thrown When Using DB2

WebLogic Integration - Business Connect and ebXML sample tests pass on all
platforms using DB 2 7.2, but the following exception is thrown by WebLogic
Integration. This condition was reported in CR068760.

COM.ibm.db2.jdbc.DB2Exception: [IBM][CLI Driver][DB2/6000]
SQL0401N The data types of the operands for the operation "=" are
not compatible. SQLSTATE=42818

Creating a Database on UNIX Systems Using Microsoft 
SQL Server

Because Microsoft SQL Server is not supported on UNIX systems, you cannot use the
createdb script (WLI_HOME/bin.createdb.*) to configure your Microsoft SQL
Server 7.0 or Microsoft SQL Server 2000 database on UNIX.

51 CR065878

Problem The B2B plug-in to the WebLogic Integration Studio does not set Sender Name correctly
with XOCP SSL.

Platforms All

Workaround Change the workflow so it does not send the message to the sender name.

52 CR066179

Problem Using ebXML messaging may hang the server with high load and low ThreadCount
settings.

Platforms All

Workaround Increase the server threadcount to approximately half the number of concurrent users
expected.
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Database Limits on Strings

WebLogic Integration limits the number of characters you can include in a string for a
B2B integration entity. If the only consideration in determining such limits were the
need to be consistent with the repository, the limit would be 256 characters. Many
other factors, however, must be considered: required indexing for deadlock
prevention, data integrity and constraints, indices on multiple columns (for example,
MessageId and DeliveryChannel), and inherent database-specific index size
limitations. Therefore, we recommend the values listed in the following table.

Displaying Spaces in the Studio 

The WebLogic Integration Studio running on a Solaris system renders spaces as empty
box characters.

Undeploying Application Integration EJB While Using 
BPM 

If the wlai-ejb-server EJB is undeployed or goes down while you are using
business process management (BPM) functionality with the application integration
plug-in, an exception similar to the following may be thrown:

Unknown error: NameNotFoundException: Unable to resolve
com.bea.wlpi.Admin. Resolved: 'com.bea.wlpi' Unresolved:'Admin'

If you then deploy the wlai-ejb-server EJB from the WebLogic Server Console,
the application integration plug-in for BPM cannot detect that it has been redeployed
and throws an exception similar to the following:

Limits on Length of Database Character Strings

Entity Oracle MSSQL Cloudscape Sybase DB2

TradingPartner 256 256 256 255 254

DeliveryChannel 252 128 256 128 254
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The server was unable to complete your request.
NoSuchObjectException: RemoteInvokable - id: '319'
java.rmi.NoSuchObjectException: RemoteInvokable - id: '319'

As a workaround, restart WebLogic Server after redeploying the wlai-ejb-server
EJB.

X Window Emulator and Telnet Connections to UNIX 

The GUI-based installer for WebLogic Integration (which is written in Java) is not
certified to run on a UNIX system reached through an X Window emulator or Telnet
connection. Instead, we recommend a direct X Window connection. You can also use
the console-mode installation procedure on UNIX systems without a graphics
(windowing) workstation.

Deploying the Plug-In Sample on UNIX Platforms 

If you see the following error message when you start WebLogic Integration on UNIX
platforms, you are probably running the software from a terminal with no graphics
capability:

Error initializing plugin:
com.bea.wlpi.tour.po.plugin.SamplePluginBeanHomeImpl@175d46
java.rmi.RemoteException: Exception in ejbCreate(); nested
exception is: java.lang.InternalError: Can’t connect to x11 window
server using “ as the value of the DISPLAY variable.
java.lang.InternalError: Can’t connect to X11 window server using
“ as the value of the DISPLAY variable.

If you are using a terminal with no graphics capability, nothing can be done about this
error. The plug-in sample cannot be deployed, and you cannot run some workflows
that require this plug-in.

If you are using an X terminal, set the DISPLAY variable, and restart the server. The
message should not appear again.
BEA WebLogic Integration Release Notes 49



Nonpersistent Mode Recommended for B2B Integration 

We recommend that you use the B2B integration functionality in nonpersistent mode.
For details about invoking nonpersistent mode, see “Configuring Persistence and
Recovery” in Administering B2B Integration.

When using B2B in persistent mode, be sure to change the defaultdeliverymode
setting for JMSConnectionFactory to non-persistence. (The default setting is
persistence.)

Collaboration Agreements Between Delivery Channels 
for the Same Trading Partner Not Supported

If you configure two XOCP delivery channels (one hub and one spoke) for a single
trading partner, with a collaboration agreement between them, and you subsequently
use the WebLogic Integration Studio to define the Start Public Workflow action for the
workflows in the associated conversation, you get a duplicate trading partner

error.

To work around this problem, do not set up one trading partner with two delivery
channels. Instead, set up two trading partners, each with its own delivery channel.
Configure a hub delivery channel for one trading partner, and a spoke delivery channel
for the other.

Problems Viewing PIP Instance Variables 

When you attempt to list the variables of certain RosettaNet PIP instances, using the
WebLogic Integration Studio, the following error may be reported:

unknown error: ClassNotFoundException:
com.bea.b2b.protocol.rosettanet.businessop.TemplateSysVariable

This TemplateSysVariable class is found in wlc.jar. To avoid this problem, put
wlc.jar in the Studio classpath. This problem was previously recorded as CR054700.
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Setting the Time Zone (TZ) Environment Variable for the 
JavaDate Type

On UNIX systems, the JavaDate type does not return a date with the appropriate time
zone indicator unless the time zone variable, TZ, is set. Ensure that the TZ environment
variable is set to the appropriate time zone.

The following example shows how to set the TZ environment variable:

TZ=US/Central
export TZ

The system administrator should set this variable before installing WebLogic
Integration 2.1 Service Pack 1. If you experience problems with the time zone indicator
on your system, contact your system administrator.

When the time zone environment variable is not set, the XML returned for a JavaDate
type field is specified in Greenwich Meridian Time (GMT) as follows:

<Date>Wed Nov 15 10:55:37 GMT-06:00 2001</Date>

When the TZ variable is set to your time zone, the XML that is returned reflects your
local time zone, as shown in the following example:

<Date>Wed Nov 15 4:55:37 CST 2001</Date>

WebLogic Integration Studio Online Help Refresh 
Limitations 

Given certain settings for file types on your system when using Microsoft Internet
Explorer as your default browser, you may encounter a limitation when refreshing
HTML frames. This refresh limitation prevents online help pages from being displayed
properly. For example, when you click the Help icon at the product user interface entry
point, the initial online help splash page should be displayed. If, while navigating the
help system, you click the Help icon again and the splash page is not reloaded as
expected, the cause of the problem is probably this refresh limitation.

To work around this limitation, change your system file type settings by completing
the following procedure:
BEA WebLogic Integration Release Notes 51



1. Choose Start→Settings→Folder Options to display the Folder Options dialog box.

Alternatively, you can double-click the My Computer icon to display the My
Computer window.

2. From the main menu, choose View→Folder Options to display the Folder
Options dialog box.

3. Select the File Types tab.

4. Using the scroll bar to the right of the Registered file types drop-down list,
review the list of file types and select HTML Document.

In the File type details field, the program specified in the Opens with field is
IEXPLORE.

5. Click Edit to display the Edit File Type dialog box.

6. In the Actions list field, select Open in Same Window.

7. Click Set Default.

8. Click Close to close the Edit File Type dialog box.

9. Click Close to close the Folder Options dialog box.

Viewing the Studio Online Help Using Netscape 
Navigator on UNIX Platforms 

To view the Online Help for individual Studio dialog boxes using Netscape Navigator
on UNIX platforms, open the browser first. Once the browser is open, you can click
the Help button in any dialog box or press the F1 key.

Prerequisites for Using a DB2 Database

If you are using a DB2 database, you must set DB2_RR_TO_RS (the DB2 registry
variable) to ON or YES before starting DB2, as shown in the following example
command lines:
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$ db2set DB2_RR_TO_RS=ON
$ db2start

In addition, before attempting to start WebLogic Server, you must correct a problem
caused by the usejdbc2 script. You must replace the Korn shell syntax in the
usejdbc2 script with Bourne shell syntax. See the workaround described for
CR062846 in the table in “Change Requests” on page 30.

B2B Console Hangs When You Enable and Register a 
Collaboration Agreement 

The B2B Console allows you to configure collaboration agreements and make them
available immediately by enabling and registering them. (For details, see “Configuring
Collaboration Agreements” in the B2B Console Online Help.)

In the following situation, however, the B2B Console may hang:

1. You choose Configuration→Parties. On the Parties tab the Enable and register this
Collaboration Agreement check box is selected.

2. You click the Add/Apply button.

To work around this limitation:

1. Deselect the check box labeled Enable and register this Collaboration Agreement,
and click Add/Apply.

2. Select the Monitoring tab and click the Enable this Collaboration Agreement link.

3. Select the Monitoring tab again (if it is not displayed), and click the Register this
Collaboration Agreement link.

Preparing to Use the Sybase jConnect JDBC 2.0 or XA 
Driver

The Sybase jConnect JDBC 1.x driver is certified with WebLogic Integration 2.1 SP1.
The driver is bundled with WebLogic Server, so extra configuration is not required.
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The JDBC 2.0 driver and the XA driver are not certified by BEA for use with Sybase
jConnect, but BEA supports them. To use either of these drivers, complete the
following procedure:

1. Obtain the latest driver:

a. Enter the following URL:
http://www.sybase.com/downloads

b. Select jConnect for JDBC in the Select a Product box. Select go.

c. Answer the prompts (a set of survey questions).

d. Store the downloadable file (delivered in zip format).

e. Unzip the file, extract jconn2.jar, and copy it to WLI_HOME/lib.

2. Configure WLI CLASSPATH by editing WLI_HOME/setenv.sh or
WLI_HOME/setenv.cmd, as follows:

� In setenv.sh file, replace the following line:

WLICOMMONCP=$WLI_LIB/wlico mon.jar

with

WLICOMMONCP=$WLI_LIB/wlicommon.jar:$WLI_LIB/jconn2.jar

� In setenv.cmd, replace the line

wlicommon.jar

with

wlicommon.jar, jconn2.jar

3. Configure WebLogic Integration to use the selected driver by changing the value
of DB_DRIVER in the appropriate file (depending on your operating system, either
WLI_HOME/config/domain/dbInfo/sybase/setDBVars or
WLI_HOME\config\domain\dbInfo\sybase\setDBVars.cmd).

� For an XA driver, click the following link:

http://e-docs.bea.com/wls/docs61/jta/thirdpartytx.html#10731

89

� For a JDBC 2.0 driver, it is "com.sybase.jdbc2.jdbc.SybDriver".

4. To make your change to the driver configuration effective, enter the following
command:
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switchdb sybase

Running Samples with WebLogic Server 6.1 SP1

The sample EJB jar files delivered with WebLogic Server 2.1 SP1 are built using the
WebLogic Server 6.1 SP2 environment. When you run WebLogic Integration samples
with WebLogic Server 6.1 SP1, the EJBs are recompiled dynamically by WebLogic
Server, which requires access to a temporary directory.

On UNIX systems a change is required to the config.xml file
(WLI_HOME/config/samples/config.xml) before the runsample command is
executed. Find the following line in config.xml:

<Application Deployed="true" Name="WLI" Path="d:\bea\wlintegration2.1\lib">

Add a trailing slash at the end of the path, as follows:

<Application Deployed="true" Name="WLI" Path="d:\bea\wlintegration2.1\lib\">

Using BEA WebLogic Integration - Business Connect 2.1

Detailed information about this component of WebLogic Integration is available at the
following URL: http://edocs.bea.com.

This section provides information about the following known limitations:

� WebLogic Integration - Business Connect Server UI displays incorrectly when it
receives a SOAP fault

� WebLogic Integration - Business Connect throws Nullpointer Exception during
Partner removal /update

� WebLogic Integration trading partners do not support POP and SMTP transports

� WebLogic Integration trading partners do not support document encryption

� WebLogic Integration trading partners do not import certificates as part of the
company profile

� WebLogic Integration trading partners require certificates in DER-encoded
binary X.509 format
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� WebLogic Integration trading partners do not support synchronous
acknowledgments (MDNs)

� Ignore the Agent Configuration fields on the Monitoring tab

� Required and recommended operating system patches

� Tuning capability

� Zeros in local IP address

� Temp directory created on FTP server

� Limitation when upgrading evaluation license key to a production license key

� WebLogic Integration - Business Connect accepts only
"application/octet-stream" as MIMEContentType for binary payloads in
outbound MCDs

WebLogic Integration - Business Connect Server UI displays incorrectly when it 
receives a SOAP fault 

When WebLogic Integration - Business Connect receives a SOAP fault, the server
window displays the word Acknowledged, which is misleading. The Tracker UI
window, as well as the Server Log, displays SOAP Fault correctly. WebLogic
Integration - Business Connect also sends back a NACK (Negative Acknowledgment).

WebLogic Integration - Business Connect throws Nullpointer Exception during 
Partner removal /update 

If you remove a partner and add a partner back during the server startup process, you
can get NullPointer exceptions because the outboundAgent has not completely started
up. Do not delete and re-add a partner during the server startup cycle.
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WebLogic Integration trading partners do not support POP and SMTP 
transports 

Although WebLogic Integration - Business Connect supports ebXML trading with
bundled HTTP, bundled HTTPS, SMTP, or POP transport, only HTTP and HTTPS are
supported with a WebLogic Integration trading partner. Do not configure the POP or
SMTP transport if you are exchanging documents with a WebLogic Integration trading
partner.

WebLogic Integration trading partners do not support document encryption 

WebLogic Integration trading partners do not support document encryption. Turn off
document encryption by clearing the encrypt documents check box on the Partner
Profile window Security tab. For secure transport, use the HTTPS transport protocol.

WebLogic Integration trading partners do not import certificates as part of the 
company profile 

When a WebLogic Integration trading partner imports a company profile that was
exported from WebLogic Integration - Business Connect, the certificate information is
not imported. Therefore, when distributing a certificate to a WebLogic Integration
trading partner, you must export the certificate to a file. The WebLogic Integration
trading partner can then import the certificate independently of the company profile.

WebLogic Integration trading partners require certificates in DER-encoded 
binary X.509 format 

When exporting a certificate to a file for use by a WebLogic Integration trading
partner, you must select the DER-encoded binary X.509 (.cer) format.

WebLogic Integration trading partners do not support synchronous 
acknowledgments (MDNs) 

WebLogic Integration trading partners do not support synchronous acknowledgments
(MDNs). Do not select the Request Synchronous Acknowledgement option on the
Partner Profile Security Tab.
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Ignore the Agent Configuration fields on the Monitoring tab

The Agent Configuration fields on the Monitoring tab of the Preferences window are
associated with a feature that is not supported. Ignore these fields.

Required and recommended operating system patches 

Patches for the following operating systems are recommended or required before
installing:

� IBM AIX 4.3.3

� Hewlett-Packard HP-UX 11.0

� Sun Solaris 2.6, 7, and 8

Details about the patches required for each operating system are provided in the
following sections.

IBM AIX 4.3.3

To obtain the JDK and the latest JDK patch for IBM AIX 4.3.3, visit the IBM Java
Technology Web page at the following URL:
http://www.ibm.com/developerworks/java/jdk/aix/index.html

HEWLETT-PACKARD HP-UX 11.0 

To obtain the required patches, visit the Hewlett-Packard IT Resource Center at the
following URL:
http://www.itresourcecenter.hp.com

Java 1.3.0

AIX version 4.3.3

LPP Name Java_dev2

Installation directory /usr/java_dev2

Latest update PTF 7 IY12075 (ca130-20001124)
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Known Limitations
The following patches are available:

SUN SOLARIS 2.6, 7, AND 8

To obtain the required patches, visit SunSolve Online at the following URL:
http://www.sunsolve.com

The following table describes the available patches.

� PHCO_19666 � PHKL_22589 � PHSS_21959

� PHCO_22314 � PHSS_17535 � PHNE_22086

� PHCO_22314 � PHSS_17535 � PHNE_22086

� PHKL_18543 � PHSS_21982 � PHSS_20863

� PHKL_20016 � PHSS_22341

Version Patch ID Note See
Footnotes

Description

2.6 (5.6) 107733-06 Required — Linker Patch

2.6 (5.6) 105568-17 Required — Libthread Patch

2.6 (5.6) 105210-27 Required — LibC Patch

2.6 (5.6) 106040-13 Required — X Input & Output Method Patch

2.6 (5.6) 105633-38 Required 1, 4, 5 OpenWindows 3.6: Xsun Patch

2.6 (5.6) 106409-01 Required 2 Fixes the Chinese TrueType fonts

2.6 (5.6) 108091-03 Required 3 SunOS 5.6: fatal error in ISO8859-01 Locales

2.6 (5.6) 106842-09 Required 4 Euro currency support

2.6 (5.6) 106841-01 Required 4 Keytables Patch

2.6 (5.6) 105181-20 Required — Kernel Update (socket close/hang)

2.6 (5.6) 105669-10 Recommended — CDE 1.2: libDTSvc Patch (dtmail)

2.6 (5.6) 105284-33 Recommended — Motif 1.2.7: Run-time library patch
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FOOTNOTES:

1. This patch is required in Asian locales.

2. This patch is required to display traditional Chinese characters in Swing
applications.

3. This patch is required for any locale in which the ISO8859-1 or ISO8859-15
character encoding is used.

4. This patch is required for support of Euro currency.

5. Required for running Java Compatibility Kit tests.

We recommend applying the Libthread patch last.

2.6 (5.6) 105591-09 Required — C++ shared library patch

2.6 (5.6) 106125-09 Required — Patch for patchadd and patchrm

7 (5.7) 106980-10 Required — Libthread Patch

7 (5.7) 107636-03 Required — X Input & Output Method Patch

7 (5.7) 108376-07 Required 1,5 OpenWindows 3.6.1 Xsun Patch

7 (5.7) 107153-01 Required 1 Replaces bad font in zh.GBK locale

7 (5.7) 106541-11 Required — Kernel update

7 (5.7) 107544-03 Required — To be used with Kernel update patch

7 (5.7) 109104-01 Required — To be used with Kernel update patch

7 (5.7) 106950-09 Required — Linker Patch

7 (5.7) 106327-08 Required — Shared library patch for C++

7 (5.7) 106300-09 Required — Patch for C++

7 (5.7) 107081-20 Required — Motif 1.2 and Motif 2.1 patch

8 (5.8) 108940-07 Required — Motif 2.1 patch available soon from SunSolve

Version Patch ID Note See
Footnotes

Description
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Known Limitations
Tuning capability 

In addition to the document tuning capabilities available on the Company Profile
Tuning tab, values in the vm.properties file in the installation directory can be
adjusted to affect application performance. We recommend that you first contact
technical support before changing values in this file. We also recommend that you
make a copy of the file for backup purposes before making any changes. For example,
you can make a copy of the file and name it vm.properties.original.

Zeros in local IP address 

In the server.log file, the local IP address is represented by a series of zeros. For
example:

� 08:47:30.904 EVENT Started SocketListener on
0.0.0.0/0.0.0.0:4080

� 08:47:30.904 EVENT Stopped SocketListener on
0.0.0.0/0.0.0.0:4080

Temp directory created on FTP server 

The application creates a temp directory on the FTP server when polling the server for
inbound documents. The application does this to make sure inbound documents are
retrieved properly.

Limitation when upgrading evaluation license key to a production license key 

When you upgrade WebLogic Integration - Business Connect evaluation license key
to production license key, all inbound/outbound protocol information of
Company/Partner profile is lost, and the status of all active Company/Partners are set
to inactive.
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WebLogic Integration - Business Connect accepts only 
"application/octet-stream" as MIMEContentType for binary payloads in 
outbound MCDs

WebLogic Integration - Business Connect accepts only “application/octet-stream” as
the value of MIMEContentType for binary payloads in outbound MCDs. When you
create an outbound MCD, set the binary payload value to “application/octet-stream”
for the MIMEContentType. WebLogic Integration - Business Connect rejects any
nonstandard type or subtype, such as application/binary, for the MIMEContentType of
an outbound MCD; however, these types are accepted for inbound ebXML messages.

BEA Developer Center

Visit the BEA Developer Center to obtain helpful resources that you might find useful
when creating your WebLogic Integration applications. Additional development tools,
ideas, and programming tips are continuously added to this site, which we encourage
you to visit often.

You can reach the BEA Developer Center at the following URL:

http://developer.bea.com/index.jsp

Contacting BEA Customer Support

If you have questions about this release of the WebLogic Integration software, if you
encounter problems while installing and running the software, or if you need to obtain
patches, contact the BEA Customer Support Center at the following URL:

http://www.bea.com/support

You can also contact your BEA Customer Support Center by using the contact
information provided on the Customer Support Card, which is included in the product
package.
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Contacting BEA Customer Support
When contacting your BEA Customer Support Center, be prepared to provide the
following information:

� Your name, e-mail address, phone number, and fax number

� Name and address of your company

� Your machine type and authorization codes

� Name and release of the product you are using

� Description of the problem and the content of pertinent error messages
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